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Introduction 

 
Thank you for purchasing a HAMAMATSU MPPC Module (also called "this product"). 
This instruction manual explains how you can use this product and how to install, connect and operate 
it. To use this product safely and correctly, read this manual carefully before use and comply with the 
instructions. 

 
This product is RoHS (Directive 2002/95/EC) compliant. 
C10751 series conforms to EU EMC directive (applicable standards: EN 61326 class B). 

 

Before using the MPPC Module 

 

■ When using this product please be sure to stay within the maximum ratings and comply with all 
caution items to avoid possible trouble or accidents. We are constantly making every effort to improve 
product quality and reliability but this does not guarantee complete safety when using this product. In 
particular, when this product is to be used in equipment or systems which might cause personal injury, 
fatal accident or damage to property if handled improperly, be sure to implement safety measures that 
take potential problems fully into account. In such applications, we bear no responsibility for problems 
or damage arising from use of this product. 

 

■ After unpacking, first check that all items are included (see the list below). If an item is missing or 
damaged, contact us immediately without using this product. 

 

■ The contents of this manual are subject to change without prior notice due to product improvement, 
etc. 

 

■ Reproduction or copying of this manual is prohibited without permission of Hamamatsu Photonics. 
 

■ If this manual is lost or damaged, immediately contact our sales office to ask for an additional copy. 
 

 

  
This product is supplied with the following items 
 MPCC Module main unit 1 
 CD-ROM 1 
 USB cable 1 
 Quick start guide 1 
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WARNING 

 

■Stop using if an abnormal condition occurs. 
If smoke, unusual odors, abnormal noise or heat are noticed while operating this product, 
immediately stop using it. Continuous operation under such abnormal conditions may cause fire or 
electrical shock. Immediately turn off the PC connected to this product and then unplug the USB 
cable. After making sure that no abnormal condition has disappeared, contact our sales office. 
Never attempt to repair on your own since it is dangerous. 

 
■High voltage hazard! 

This module includes a high-voltage power supply needed to operate the MPPC. The high-voltage 
power supply is coated with silicone resin to prevent electrical shock. Do not remove the coating 
material or touch internal parts of this product. 

 
■Do not apply vibrations or shocks to this product. 

Excessive shocks or vibrations may damage the internal components or adversely affect their 
adjustments, causing fire or electrical shock. 

 
■Always connect this product to a USB port. 

This product is designed to connect to a USB port on a PC. Fire or electrical shock may result if 
used at a voltage higher than the USB voltage. 

 
■Do not disassemble. 

Do not disassemble any part of this module. Changing the adjustment or modifying this module may 
cause malfunctions and lead to fire or electrical shock. 

 
■Keep away from water or any liquid. 

Electrical shock or damage may occur if the module gets wet. 
 
■Handle the cables properly. 

Avoid placing any heavy objects on the cable or bringing a heater close to the cable. Do not pull on 
the cable itself when disconnecting it. Doing so might damage the cable and cause fire or electrical 
shock. 
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Handling precautions 

 
Before using this product, be sure to read the following precautions to ensure correct and safe use. 
 
■ Do not use organic solvent such as thinner and acetone for cleaning. Use a soft dry cloth to 

wipe the surface of this product clean. 
 
■ Ceramics Series (-xxxC) Cleaning. 

Since the window of this product is made with soft resin, don’t push nor touch the window surface by 
the hard or tip object. 
If the window needs to be cleaned, use ethyl alcohol and wipe off the window gently. 

 
■ Install the evaluation software in your PC only after you accept the terms in the "Software license 

agreement". Do not connect this product to the PC before installing the evaluation software. 
Otherwise, the software installation may fail. (See the description in "Setup" for how to install the 
software.) 

 
■ Power to this product is supplied from the USB port on the PC.  
 
■ Due to the USB specifications, the maximum power that can be supplied from one USB port is 

limited to 5 V, 500mA. Avoid connecting two or more units to one USB port through a hub. 
 

 Current consumption[mA] 
MPPC Module 200 

 
■ Power saving function and screensaver.  

Depending on the PC model, the power supplied from the USB port might be interrupted when the 
power saving function or screensaver is activated. In this case, this product also stops operation 
and might create problems when the PC returns from power saving or screensaver mode. 
If power to your PC is interrupted in this same way while connected to this product, disable the 
power saving function and screensaver. (For PC functions and settings, see the PC operation 
manual.) 
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Overview 

 
The MPPC module is a semiconductor photo detector capable of detecting very low light levels. It has an  
MPPC (multi-pixel photon counter) device which consists of multiple APD pixels operable in Geiger 
mode with high gain (105 to 106). The MPPC module is made up of an MPPC, current-to-voltage 
conversion circuit, high-speed comparator circuit, high-voltage power supply circuit, 
temperature-compensation circuit, counter circuit, and microcomputer. Handling the MPPC module is 
very easy, since it operates on USB bus power and no external power supply is required. Three kinds of 
outputs are available: analog output, comparator output, and counter output (via USB), which are 
selectable according to the application. The threshold level of the counter can also be changed by USB 
communication. Operating the MPPC module requires high-precision voltage control because the MPPC 
is used in Geiger mode where the gain greatly depends on changes in bias voltage and also because 
the usable bias voltage range is narrower than that for normal APD devices. This module uses a 
microcomputer to control the bias voltage with high accuracy, allowing stable MPPC operation.  
The MPPC module is expected to open up new applications in the photon counting region, including 
fluorescence lifetime measurement, flow cytometry, drug discovery, scientific research, various 
measurement, chemical analysis, and many more fields. 
 
  ■Features 
  ♦Integrates a signal readout circuit ideal for MPPC 
  ♦Built-in high-voltage circuit and temperature-compensated circuit 
  ♦Three types of output: analog, comparator and pulse calculation value 
  ♦USB interface for easy handling: driven by USB bus power 
  ♦Compact and lightweight 
 

  ■Applications 
  ♦Fluorescence lifetime measurement 
  ♦Biological flow cytometry 
  ♦Bioluminescence analysis 
  ♦Ultra low light detection 
  ♦Analysis equipment 
 

  ■Block diagram 
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Basic configuration and description of terms 

 

■ Measurement setup for MPPC module evaluation 

Optical fiber Photon

Light source 　Optical attenuator 　MPPC Module Oscilloscope

　　　　Trigger signal

PC

 
 

Power is supplied from the PC to the MPPC module via the USB cable. The PC also makes various 
settings and monitors the counter value.  
The counter value can also be obtained by connecting the comparator output to a frequency counter, 
etc. 
Connecting the analog signal to an oscilloscope allows monitoring the signal. 
 

  
Analog output waveform 

C10507-11-025U, C10507-11-025C, C10751-01
Analog output waveform 

C10507-11-050U, C10507-11-050C, C10751-02

  
Analog output waveform 

C10507-11-100U, C10507-11-100C, C10751-03 Comparator output waveform 
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■ Analog output 
The analog output waveform from the MPPC module is adjusted so that a pulse of 100 mV is 
obtained at 1 p.e. (equivalent to detecting 1 photon). If two or more photons are detected at the 
same timing, then the pulses pile up for output. 
 

2p.e.

1p.e.
200mV

100mV

Time→  
MPPC module output waveform measured by oscilloscope 

 
■ Gate time 

This is a time width during which the number of input counts is integrated within the MPPC 
module. 
Gate time is adjustable from a minimum of 1 ms to a maximum of 100 ms. 

 
■ Threshold level 

Setting the threshold level to one-half (0.5 p.e.) the height of the 1 p.e. pulse and then using a 
frequency counter to count the number of pulses exceeding this threshold level allows measuring 
the number of detected photons. The threshold level can be selected from 5 different settings (0.5 
p.e. / 1.5 p.e. / 2.5 p.e. / 3.5 p.e. / Disable) on the evaluation software. 

 

2p.e.

1p.e.

Time→

0.5p.e.

1.5p.e.

 
MPPC module output waveform measured by oscilloscope 

 
■ Dark count 

On the MPPC module, the dark count is defined as the number of counts measured with no light 
incident on the MPPC and with the threshold level set at 0.5 p.e. 
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Connecting and disconnecting the units 

 
Procedures for connecting and disconnecting the units are explained below. 
 
The MPPC module outputs a count of pulses that exceeded the preset threshold level, to the PC via 
the USB cable. Power to the MPPC module is supplied from the PC, so no additional power supply is 
needed at this point. 

 
■ To connect 

 
* Never connect the MPPC module to the PC before installing the software in the PC. Otherwise 
the software might not be installed correctly. (See the section "Installing the software".) 

 
(1) Connect the USB-A plug of the USB cable (supplied with unit) to the USB port on the PC. 

(2) Connect the USB mini-B plug of the USB cable (supplied with unit) to the USB connector on the 
MPPC module. 

 
■ To disconnect 

 
(3) First, quit the MPPC software (evaluation software installed from the CD-ROM). 

(4) Remove the USB cable from the USB connector on the MPPC module. 

(5) Remove the USB cable from the USB port on the PC. 
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Evaluation software 

 

What is the sample software? 

To use the MPPC module, it must first be connected to a PC through a USB 1.1 interface. Various 
MPPC operations are performed on the PC, and the measured data is transferred to the PC. 
The sample software is free evaluation software that comes with the MPPC module. It is designed to 
easily perform basic MPPC module operations. Using the sample software allows you to make 
measurements on the MPPC module right after the setup. Basic functions of the sample software are 
acquiring data, displaying measurement data graphs, and saving data. 
 

System requirements 

Evaluation software operation has been verified on the following systems. Operation on other 
systems is not guaranteed. 

 
Microsoft Windows 2000 Professional SP4 
Microsoft Windows XP Professional SP2 
 

To operate the sample software, you must use a PC that meets the above system requirements. 
Although there are no other special requirements, we recommend using a PC with a 
high-performance CPU and a large capacity memory. A high-performance CPU and large memory 
are especially important when operating two or more MPPC modules simultaneously. 
 

Limit on number of connectable modules 

The USB standard supports up to 127 units of the same device connectable to one PC. So up to 
127 MPPC modules can theoretically be connected and operated simultaneously. However, 
problems with the actual physical connection act to limit the maximum number of units that can 
correctly operate while connected. 
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Setup 

 
Install software that can control the MPPC module from a personal computer (PC). The following 
explains the procedure for installing the sample software using Windows XP Professional SP2. To 
install the sample software, log in as a user with administrator rights. (* Always first install the 
software. Do not connect the MPPC to the PC and then try to install the device driver manually 
before installing the software.) 

 
 

【Installing the software】 

After Windows has started, insert the supplied 

CD-ROM into the DVD/CD-ROM drive on the PC. 

When the auto run for the CD is enabled, the installer 

automatically starts. If the installer does not start, 

double-click "Setup.exe" on the CD-ROM to start 

the installer. 
 

 
When the "Welcome" window appears, click 
[Next]. 

 
The license agreement window appears. Read 
through the contents carefully. If you accept the 
agreement, click [Yes]. You may not install the 
sample software unless you accept the terms of 
the license agreement. 
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Select the components you want to install.  
Select "Complete" (default) in most cases, and 
then click [Next]. 

 
The window for copying files appears. It shows a 
list of components to be installed. Click [Next]. 

 
Make sure that the MPPC module is not 
connected to the PC and then click [OK]. 

 
The software installation starts. 
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This screen appears when the installation is 
complete. Click [Finish] to end the installation 
wizard. 
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【Installing the device driver】 
For Windows XP, please install the device driver to the following procedures. It is installed automatically for 
Windows 2000. 
The device driver must be installed when you connect the MPPC module for the first time to the PC. If you 
connect two or more MPPC modules to the PC, repeat the same procedure to install the device driver for 
each MPPC module. When the PC has two or more USB ports and you connect the MPPC module to 
another USB port, you will have to repeat the same procedure to install the device driver. 

 
Connect the MPPC module to the PC. The MPPC 
will be detected as new hardware and the "Found 
New Hardware Wizard" will appear to guide you 
through the device driver installation. Select "No, 
not this time" and click [Next] to continue. 

 
Select "Install from a list of specific location 
(Advanced)" and click [Next] to continue. 

 
* If you select "Install the software automatically 
(recommended)" while the PC is connected to a 
LAN, the PC will search for the device driver via 
the network, possibly causing no response. 
Always select "Install from a list of specific 
location (Advanced)". 

 
Select "Don't search I will choose the driver to 
install" and click [Next] to continue. 
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Make sure the "Show compatible hardware" check 
box is checked (default), select "MPPC USB 
Module" in the "Model" list, and click [Next] to 
continue. 

 
The device driver installation starts. 

 
This screen appears when the installation is 
complete. Click [Finish].  
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【Uninstalling the software】 

First disconnect the MPPC from the PC. 
From the [Start] menu, select [All Programs] → [Hamamatsu MPPC Module] → [Change or 
Remove]. 

 
 

When this screen appears, select "Remove", 
then click [Next]. 

 
 

When this confirmation message appears, click 
[OK]. 

 
 

If the MPPC is connected to the PC, disconnect 
it from the PC and then click [OK]. 

 
 

Uninstallation starts. 
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This screen appears when uninstallation is 
complete. Click [Finish]. 

 
 

After uninstallation, this screen appears asking if 
you want to restart the PC. Select "Yes, I want 
to restart my computer now" and then click 
[Finish]. 
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Software operation 

 
Never disconnect the MPPC from the PC while the software is running. If disconnected, 
trouble might occur on the Windows system. 

 

【Starting the software】 

Connect the MPPC to the PC using the USB cable. 
Double-click the  short-cut icon created on the desktop, or from the [Start] menu select [All 
Programs] → [Hamamatsu MPPC Module] → [Software] → [Evaluation]. 
 
The "Select MPPC Module" dialog box first appears. From the drop-down list, select the MPPC 
module to be used, and then click [Select]. (Figure A) 

 

 Figure A: Selecting the MPPC module to be used 
 
When the "Option" dialog box appears, select the operating conditions from the "Gate Time [ms]" 
and "Threshold Level" drop-down lists. The gate time can be selected from 7 different settings (1 / 
2 / 5 / 10 / 20 / 50 / 100 ms). The threshold level can be selected from 5 different settings (0.5 p.e. 
/ 1.5 p.e. / 2.5 p.e. / 3.5 p.e. / Disable). After selecting the conditions, click [Update] (see Figure B). 
The dialog box closes and the software screen then appears (see Figure C). You are now ready to 
start measurements. 
If "Disable" is selected for the threshold level, no data can be acquired. Select this setting only 
when using the analog signal output from the MPPC module. 
 

  Figure B: Selecting the operating conditions 
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  Figure C: Software screen right after start-up 

【Measurement: Start and stop】 

To start measurement, select [Start] from the [Monitor] menu as shown in Figure D, or click the  
 button on the toolbar. 

To stop measurement, select [Stop] from the [Monitor] menu (see Figure E) or click the  
button. 

 

 Figure D: Starting measurement 
 

 Figure E: Stopping measurement 
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【Software screen configuration】 

 
Figure F: Screen configuration 

 
① Shows the current count rate [kcps]. 
② Shows the number of input counts per gate time. (* Not in "cps" units) 
③ Shows the current option settings and temperature information. 

 
   The graph is a time-series display and is updated every 100 ms. 
   (Measurement data is thinned out and plotted on the graph.) 

 
 

【Changing the options】 

To change the measurement conditions, select [Option] from the [Monitor] menu (see Figure G) or 
click the  button on the toolbar. 

 

 Figure G: Changing the options 
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【Saving the data】 

To save the data, stop the measurement and then select [Save] from the [File] menu (see Figure H) 
or click the  button on the toolbar. Then, in the dialog box that appears, specify a file name for 
saving the data. The data is saved in text format (*.txt). 

 

 Figure H: Saving the data 
 
 

The sample software stores data acquired during measurement (from the start to stop of 
measurement) into the memory. That data is retained in the memory until the next measurement 
begins.  
Data saved with the [Save] command or button are the operating condition settings and number 
of input counts per gate time. 
(Example) If measurement is performed for 1 hour with a gate time of 10 ms, then a total of 
360,000 data items (1 hour / 10 ms = 360,000) will be acquired. 
The maximum number of data the memory can hold is 3,600,000 (this is equivalent to a 1-hour 
measurement with 1 ms gate time). If this value is exceeded, then new data will overwrite the old 
data starting from the oldest one. 

 
 

【Others: Graph manipulation】 

This sample software includes display tools such as zoom-in ( ) of a selected area, auto scaling 
( ), vertical scale setting option ( ), and cursor display ( ). 

 

 Figure I: Display tools 
 

【Quitting the software】 

To quit the software, select [Exit] from the [File] menu. 
 



< 21 > 

 

【Tool button description】 

Name Icon Menu and description 

[File] → [Save] 
Save 

 Saves acquired data. 

[View] → [Area] 
Zoom 

 Zooms in on selected area. 

[View] → [Auto] 

Auto 
 

Sets the graph display scale automatically or 

resets the zoom display. 

[View] → [Option] 
Option 

 Specifies the vertical axis scale. 

[View] → [Cursor] 

Graph 

Cursor 
 

Changes to "cursor" mode and shows a cursor 

line. 

[Monitor] → [Start] 
Start 

 Starts data acquisition. 

[Monitor] → [Stop] 
Stop 

 Stops data acquisition. 

[Monitor] → [Option] 

Measurement 

Option 
 Changes the measurement conditions. 
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Software license agreement 

 
Please carefully read the following conditions (hereafter called, "product license agreement") in this 
document. Hamamatsu Photonics K. K. (hereafter, "Hamamatsu Photonics") grants usage of the 
software such as MPPC Module evaluation software and related DLL files (hereafter called, "this 
software") only to those users accepting the conditions of this product license agreement.  
By installing this software, you agree to be bound by these terms and conditions. If you do not agree to 
these terms or conditions in whole or in part, do not install or use this software. 
 
1. Objective of this software 

This software is control software provided free of charge and without warranty under this product 
agreement for the convenience of users wishing to use a Hamamatsu Photonics MPPC Module 
(hereafter called, "MPPC Module"). 

 
2. Granting of usage rights 

Hamamatsu Photonics grants you the right to install this software and control the MPPC Module, 
only when you agree to the terms and conditions of this product license agreement. 

 
3. Copyrights and other rights 

Intellectual assets and owner rights to this software and accessory documents and all other rights 
are owned by Hamamatsu Photonics. This software is protected by laws and international 
agreements involving intellectual assets such as copyrights. You must not alter or remove any 
copyright markings attached to this software or the accessory documents. 
Other than the terms specifically granted in this product license agreement, Hamamatsu 
Photonics retains all rights relating to this software and accessory documents and does not grant 
or concede rights of any kind to you. 

 
4. Copying 

You are allowed to copy this software for the purpose of making a backup, under the condition 
that you respect and obey all terms and conditions of this product license agreement. 

 
5. Prohibited actions 

You must not perform the following actions. However, if you grant, lease or lend the MPPC 
Module to a third party, then when you deliver the MPPC Module along with this software to the 
applicable third party, Hamamatsu Photonics grants use of this software to the applicable third 
party under the continuing product license agreement, when the applicable third party accepts the 
terms and conditions of this product license agreement. 

① Activities such as the sale and distribution of this software to a third party, and or 
advertising, display, use, copying, and sales with the objective of selling and distributing 
this software to a third party. 

② The transfer or re-granting of the usage rights for this software to a third party. 
③ The setting as collateral, or lending, leasing of this software to a third party. 
④ The altering or eliminating all or a portion of this software, including this product license 

agreement and other accessory documents. 
⑤ The copying, adaptation, translation, reverse engineering, disassembly or decompilation 

or use of other methods for revealing the source code, in whole or in part of this software. 
 
6. Limits on liability 

Hamamatsu Photonics provides absolutely no assurance of the quality, performance or fitness for 
a particular purpose of this software and accessory documents. Hamamatsu Photonics accepts 
absolutely no liability in any event whatsoever, for computer breakdowns, losses or damage, 
destruction of information, or other losses of any kind arising directly or indirectly from the use or 
inability to use this software and accessory documents. Hamamatsu Photonics offers no 
maintenance or support for this software, and further accepts no responsibility for making repairs 
or restorations even when a problem or obstacle has occurred. 
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Warranty and after-sales service 

 
■ Warranty 

The following warranty applies to the Hamamatsu MPPC Module unless specifically covered by a 
separate warranty. 

 
This product is warranted for a period of one year from the date of delivery to the original purchaser. 
If a failure occurs due to defects in workmanship or materials within this warranty period, 
Hamamatsu will repair or replace (at our option) the product without charge. The warranty is limited 
to repair or replacement of this product and shall not apply to secondary failures or accidents, 
physical injury, or damage to the connected equipment, which were caused or induced by this 
product. 

１） Failure or trouble was caused by incorrect handling. 
２） The product was used for a purpose other than the original purpose. 
３） The product was serviced or modified electrically or mechanically by someone other than our 

service personnel or authorized personnel. 
４） Failure or trouble was caused by accidents such as natural or man-made disasters. 
５） Failure or trouble was due to another piece of equipment used with this product. 

 
 
 

■ After-sales service 
If a failure has occurred after extended periods of operation which was caused by long-term wear on 
replaceable parts, ship the product back to us for repair, replacement and adjustment. 
We will make every effort to repair the returned product in as short a time as possible. However, the 
repair or adjustment might require extra time if the product was purchased a long time ago. The 
repair might also be refused if the maintenance parts in the product are not in current production or 
the product is severely damaged. 
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Appendix 

 

A.Specifications 

•C10507-11-025U, C10507-11-025C, C10751-01 

Parameter Condition Min. Typ. Max. Unit 

Operating temperature  -10 to +40 °C 

Storage temperature  -20 to +50 °C 

Effective active area  1 × 1 mm 

Number of pixels  1600 - 

Spectral response range  320 to 900 nm 

Peak sensitivity wavelength  440 nm 

Photon detection efficiency*1 λ=400nm, 
0.5p.e. - 20 - % 

Dark count 0.5p.e. - 500 900 kcps 

Temperature stability of analog 
output voltage 25±10°C - ±2.5 ±5 % 

Analog output voltage  80 100 120 mV/p.e. 

Comparator output  TTL compatible - 

Comparator threshold level  0.5, 1.5, 2.5, 3.5, Disable 
Adjustable 5 state p.e. 

Interface  USB1.1 - 

      *1: Photon detection efficiency includes effects cross talk and after pulses. 



< 25 > 

 
• C10507-11-050U, C10507-11-050C, C10751-02 

Parameter Condition Min. Typ. Max. Unit 

Operating temperature  -10 to +40 °C 

Storage temperature  -20 to +50 °C 

Effective active area  1 × 1 mm 

Number of pixels  400 - 

Spectral response range  320 to 900 nm 

Peak sensitivity wavelength  440 nm 

Photon detection efficiency*1 λ=400nm, 
0.5p.e. - 35 - % 

Dark count 0.5p.e. - 600 1200 kcps 

Temperature stability of analog 
output voltage 25±10°C - ±2.5 ±5 % 

Analog output voltage  80 100 120 mV/p.e. 

Comparator output  TTL compatible - 

Comparator threshold level  0.5, 1.5, 2.5, 3.5, Disable 
Adjustable 5 state p.e. 

Interface  USB1.1 - 

      *1: Photon detection efficiency includes effects cross talk and after pulses. 
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• C10507-11-100U, C10507-11-100C, C10751-03 

Parameter Condition Min. Typ. Max. Unit 

Operating temperature  -10 to +40 °C 

Storage temperature  -20 to +50 °C 

Effective active area  1 × 1 mm 

Number of pixels  100 - 

Spectral response range  320 to 900 nm 

Peak sensitivity wavelength  440 nm 

Photon detection efficiency*1 λ=400nm, 
0.5p.e. - 45 - % 

Dark count 0.5p.e. - 900 1500 kcps 

Temperature stability of analog 
output voltage 25±10°C - ±2.5 ±5 % 

Analog output voltage  80 100 120 mV/p.e. 

Comparator output  TTL compatible - 

Comparator threshold level  0.5, 1.5, 2.5, 3.5, Disable 
Adjustable 5 state p.e. 

Interface  USB1.1 - 

      *1: Photon detection efficiency includes effects cross talk and after pulses. 
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B. Dimensional outline (Unit: mm) 

•C10507-11-025U, C10507-11-050U, C10507-11-100U 
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•C10507-11-025C, C10507-11-050C, C10507-11-100C 
 

 
 

 

 



< 29 > 

 

•C10751 series 
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Microsoft and Windows are the registered trademarks of Microsoft Corporation in the United States 
and/or other countries. 
Other company and product names mentioned herein may be the trademarks or registered trademarks 
of their respective owners. 
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